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Figure 1: Overview of the graphical user interface.
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Introduction

Drop is a software for deformable image registration using discrete optimization. The method is based on the publications [3, 4, 2]. In this user guide we
describe the basic functionality of the software and the algorithm’s parameters. Hopefully, this document will help users to run our software in order to
obtain good registration results. As this software presents research work in
progress, bugs and typos of any kind are very likely, within this document as
well in the software. We appreciate any comments, suggestions, or critics regarding our software. Feel free to contact us via mail: glocker@in.tum.de (Ben
Glocker). Latest news, bug ﬁxes, and new versions will always be announced
on our website http://www.mrf-registration.net.

2
2.1

Files and Data
Loading Images

Images can be loaded using the File menu. Currently, the MHD format and
the Analyze format are supported in both the 2D and 3D application. A
simple DICOM support based on the GDCM library is provided as well. In
3D, it is possible to load single DICOM series located in one folder. In 2D it
is also possible to load single DICOM slices as well as BMP, PNG, and PGM.
Please note, that our registration is using gray value information only. RGB
images will be converted to grayscale according to
Igray = (11 · Ired + 16 · Igreen + 5 · Iblue ) /32
Note: In the current version, the images to be registered have to have the
same resolution and physical pixel/voxel size. An image is automatically re2

Figure 2: Registration with data mask.
sampled, if another image with diﬀerent size is already loaded. Before loading
a new set of images, the loaded images should be closed using Close All Images
from the File menu. Please note, that the registration is considering the physical spacing and all parameters are given in millimeters. It is very important,
to have the correct spacings in the header ﬁles of the images, especially in 3D
with anisotropic voxels.

2.2

Data Masks

Optionally, a data mask can be loaded using Load Data Mask from the File
menu. The data mask is a binary image of the same size as the images to
be registered. Mask pixels/voxels with intensity zero are not considered when
computing the similarity measure. The data mask can be removed using Close
Data Mask.

2.3

Saving Results

The registration results can be saved in the MHD format only. The registered
(deformed) image is saved using Save Deformed Image from the File menu.
Additionally, the deformation ﬁeld can be saved using Save Deformation Field.
For the ﬁeld, one MHD image is created per displacement dimension. An
approximation of the inverse ﬁeld can be saved using Save Inverse Deformation
Field. The inverse ﬁeld is computed from the original ﬁeld using a thin-plate
spline with equally distributed control points over the whole domain. The
original ﬁeld is then used as point correspondences in the evaluation of the
thin-plate spline warping.
Note: The registration is using backward-warping for the image transformation. Thus, the displacements in the deformation ﬁelds will appear as pointing
in the opposite direction of the actual motions.
3

Figure 3: Landmark-based registration Tool.

2.4

Applying the Deformation Field

After registration, the deformation ﬁeld can be applied to an external image
using Transform External Image from the Tools menu. For instance, this can
be useful if a segmentation saved in another ﬁle should be warped accordingly
to the registration.

2.5

Landmark-based Pre-Registration

A simple landmark-based registration tool is provided. After loading two images, the landmark-based registration can be started by choosing Landmark
Registration from the Tools menu. In 2D, at least four point correspondences
have to be selected while eight points are needed for 3D. After choosing appropriate correspondences, the images can be pre-registered by an rigid, similarity,
aﬃne, or thin-plate spline warping. To accept the pre-registration, one has
to click on Accept Result and the image is passed to the deformable registration application. It is possible to load and save correspondences from/into a
simple text ﬁle. After accepting the result of the landmark registration, the
corresponding displacement ﬁeld, the inverse ﬁeld, and the warped image are
saved to the hard disk.

3

Registration Parameters

The registration tab is used to set the parameters of the registration algorithm.
Each of the parameters will be explained in the following sections.

3.1

Control Grid Settings

The control grid deﬁnes the transformation model used for the registration.
The size of the grid as well as the number of pyramid levels and the interpolation technique are application speciﬁc settings. In medical data, assuming
4

a global pre-registration, common parameters are for instance to start with
a 20 mm control point spacing and a three level grid pyramid. When the
algorithm switches to higher pyramid level, the control grid resolution as well
as the image resolution is increased.
Set Distance (mm):

Sets the total number of image pyramid levels.

Image Levels:
Grid Levels:

Sets the initial control point distance in millimeters.

Sets the number of control grid levels.

Min. Dimension: Sets the minimum resolution which will be preserved
when generating an image pyramid.
Interpolation: Sets the interpolation method used to compute the dense
deformation ﬁeld.
Image Margin: Sets the boundary image margin in millimeters which is
excluded from the similarity computation.
Update Mode:

Selects the displacement ﬁeld update mode.

Note: The combination of compositional updates and the Link Maximum
To Grid option from the label set settings provides diﬀeomorphic deformation
ﬁelds [7, 10]. The hierarchical registration is now controlled with two parameters – the image levels and the grid levels. The grid levels deﬁne the number of
hierarchical iterations while the image levels only deﬁnes the number of levels
used for the image pyramids. For example, if the number of image levels is
set to 3 and the grid levels is set to 2, then the registration is performed only
on the ﬁrst two image pyramid levels with one subdivision of the grid. If the
number of grid levels is set to 3 and number of image levels is set to 1, then
the registration on all three grid levels is performed on the original resolution
of the images. The minimum resolution parameter has an inﬂuence on the
image pyramid. It is important to constrain the pyramid in certain cases. For
example, oftentimes volumes have a very diﬀerent resolution in z-direction.
An 512 × 512 × 32 image should not be rescaled in all dimension by a factor
of 2. In fact, the small number of 32 slices should be preserved which can be
enforced by setting the Min. Dimension parameter.
There are now three ways how the displacement ﬁeld is updated after each
iteration. Additional mode simply adds the dense displacement ﬁeld update
after each iteration. Compositional mode composes the updates by using linear
interpolation. Both modes keep only the dense ﬁeld in memory and the control
points are reset to their initial position after each iteration. The Consecutive
mode keeps the control grid deformation and updates are directly added to
the control point displacements.
5

3.2

Label Set Settings

The label set deﬁnition is crucial for a successful registration. The labels
deﬁne the search space for the displacements, but also inﬂuence the run time.
The number of labels has to be chosen in a way to ﬁnd a good compromise
between speed and registration accuracy. In practice, it turned out that only
a few labels are needed to perform a good registration. Due to the hierarchical
approach in a coarse-to-ﬁne manner, a sparse sampling of the search space is
often suﬃcient.
Sparse/Dense Sampling: Sets the sampling method for the displacement
space. A sparse sampling is generating displacements along the 8 main directions in 2D (vertical, horizontal, diagonal) and the 6 main directions in 3D (x-,
y-, z-axis). The dense sampling is producing displacements equally distributed
over an rectangular (2D) or cubic (3D) domain.
Link Maximum To Grid: Enables the displacement capture range to be
sticked to the control grid resolution. The initial maximum displacement is
set automatically to 0.4 times the control point spacing.
Maximum (mm): Sets the initial maximum value for the capture range
manually. This is disabled if the link to maximum es enabled.
Steps: Sets the number of sampling steps. If sparse sampling is enabled, the
total number of labels/displacements is |L| = 8N + 1 in 2D and |L| = 6N + 1
in 3D. If dense sampling is enabled, it becomes |L| = (N + 1)2 respectively
|L| = (N + 1)3 . The +1 accounts for the zero-displacement.
Label Factor: Sets the scaling factor for the capture range used after each
optimization cycle. Thus, on each level the search space for the displacements
is reﬁned after each cycle which enables high accuracy registration results.
Note: The number of labels signiﬁcantly inﬂuences the run time of the registration, since for each additional label the similarity measure has to be computed using the approximation scheme described in [4]. In practice, a sparse
sampling is mostly suﬃcient when using the hierarchical approach and a sufﬁcient number of iterations.

3.3

Optimization Settings

In the optimization settings, the actual cost function is deﬁned which is subject
to minimization.
Optimizer: Sets the discrete optimization method used for minimizing the
cost function. Currently, only the FastPD [6] algorithm is available.
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Data Cost: Sets the similarity measure. The following measures are currently available:
1. SAD: Sum of Absolute Diﬀerences
1 
E(T ) =
|I1 (x) − I2 (T (x))|
|Ω|

(1)

x∈Ω

where I1 and I2 are the target and source images and T is the transformation.
2. SADG: Sum of Absolute Diﬀerences plus Sum of Gradient Inner Products
E(T ) =


1
(1 − γ) ·
|I1 (x) − I2 (T (x))|
|Ω|
x∈Ω


  ∇I1 (x) ∇I2 (T (x)) 


+γ
 |∇I1 (x)| · |∇I2 (T (x))|  (2)
x∈Ω

where γ controls the balance between the two terms.
3. SSD: Sum of Squared Diﬀerences
E(T ) =

1 
(I1 (x) − I2 (T (x)))2
|Ω|

(3)

x∈Ω

4. NCC: Normalized Correlation Coeﬃcient







x∈Ω (I1 (x) − μ1 ) (I2 (T (x)) − μ2 )


E(T ) = −  

2
2 

x∈Ω (I1 (x) − μ1 )
x∈Ω (I2 (T (x)) − μ2 )

(4)

5. NMI: A normalized version of mutual information (Entropy Correlation
Coeﬃcient) [8]
2 MI(I1 , I2 ◦ T )
(5)
E(T ) = −
H(I1 ) + H(I2 ◦ T )
where MI is the mutual information and H is the entropy. Uses the
parameter Histogram Bins for deﬁning the number of bins used for the
estimation of the probabilities.
6. CR: Correlation Ratio [9]
E(T ) = −CR(I1 |I2 ◦ T )

(6)

Uses the parameter Histogram Bins for deﬁning the number of bins used
for the estimation of the probabilities.
7. GRAD: Sum of Gradient Inner Products


1   ∇I1 (x) ∇I2 (T (x)) 
E(T ) =
 |∇I1 (x)| · |∇I2 (T (x))| 
|Ω|
x∈Ω
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(7)

8. CCGIP: Normalized Correlation Coeﬃcient plus Sum of Gradient Inner
Products
⎞
⎛ 





(I
(x)
−
μ
)
(I
(T
(x))
−
μ
)
1
1
2
2
⎠
E(T ) = (1 − γ) ⎝−   x∈Ω
2
2 

x∈Ω (I1 (x) − μ1 )
x∈Ω (I2 (T (x)) − μ2 )

  ∇I1 (x) ∇I2 (T (x)) 


+γ
 |∇I1 (x)| · |∇I2 (T (x))|  (8)
x∈Ω

where γ controls the balance between the two terms.
9. HD: Hellinger Distance

E(T ) =

p1 (I1 (x)) −

p2 (I2 (T (x)))

2

(9)

x∈Ω

Uses the parameter Histogram Bins for deﬁning the number of bins used
for the estimation of the probabilities.
10. JRD: Jensen-Renyi Divergence [5] where γ controls the parameter α described in the paper :-). Uses the parameter Histogram Bins for deﬁning
the number of bins used for the estimation of the probabilities.
11. MI: Mutual Information [8]
E(T ) = − (H(I1 ) + H(I2 ◦ T ) − JE(I1 , I2 ◦ T ))

(10)

Uses the parameter Histogram Bins for deﬁning the number of bins used
for the estimation of the probabilities.
12. JE: Joint Entropy

p(I1 (x), I2 (T (x))) · log(p(I1 (x), I2 (T (x))))
E(T ) = −

(11)

x∈Ω

Uses the parameter Histogram Bins for deﬁning the number of bins used
for the estimation of the probabilities.
Distance:
tion ﬁeld.

Sets the penalty function used for regularization of the deforma-

1. Pott’s: A simple Pott’s model penalizing deviations in the displacement
assignments.
2. Truncated Absolute Diﬀerence: Penalizes the magnitude of vector differences between the displacements of two neighboring control points.
3. Truncated Quadratic Diﬀerence: Penalizes the squared magnitude of
vector diﬀerences between the displacements of two neighboring control
points.
4. Approximated Curvature Penalty: Penalizes the approximated secondorder derivatives of the displacement ﬁeld [2].
5. Distance Preserving: Penalizes changes in the distances between neighboring control points.
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Projection: Sets the basis functions used for the back-projection of similarity measures (compare η̂ in [4]). This parameter also selects the size of the
image patch contributing to the similarity evaluation for each control point. If
the projection is set to Nearest, only the closest pixels/voxels have an inﬂuence
on the cost for moving a control point. A projection set to Linear considers all
image points in the neighboring control grid cells, while Cubic B-Splines have
the largest inﬂuence area (in 2D the 16 closest grid cells). The actual image
point weightings deﬁned by the selected basis function are only considered
for point-wise similarity measures such as SSD and SAD. For the others, the
projection parameter is only deﬁning the patch size used for evaluating the
local similarity (cp. [4]).
Incremental Regularization: Enables incremental regularization, meaning only the updates of the displacement ﬁeld are penalized using the selected
penalty function. If disabled, the whole displacement ﬁeld over time is regularized.
Iterations: Sets the number of optimization cycles per pyramid level. After
each of these cycles the label set is reﬁned using the Label Factor parameter.
Gamma: Sets the γ parameter which is used for similarity measures such
as SADG, CCGIP, JRD.
Lambda: Sets the λ parameter which controls the inﬂuence of the regularization term. This parameter is quite sensitive w.r.t. to the selected similariy
measure, but also depends on the speciﬁc regularization method. A good
strategy for ﬁnding a suitable value for λ is to start with a high value (e.g.
1000). If the result of the registration is only a rigid translation of the control
grid, the value of λ can be successively halved until the control grid has enough
ﬂexibilty for reasonable deformations.
Truncation: Sets the truncation threshold for the regularization terms. If
set to zero, no truncation is used. In practice, a truncation of the regularization
allows certain discontinuities in the regularization (cp. [1]).
Histogram Bins: Sets the number of bins used for the histograms. This
parameter is needed for statistical similarity measures such as MI, NMI, CR,
HD, JRD, JE.

3.4

Parameter File

The registration parameters can loaded from and saved into simple text ﬁles.
A example ﬁle with brief descriptions for the parameters can be found in the
applications directory. The buttons Load, Save, and Reload above the label
set settings can be used to load, save, and reload a parameter ﬁle.
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